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1. Disclaimer 
 
This program is free software; you can redistribute it and/or modify it under the terms of the GNU 
General Public License as published by the Free Software Foundation; either version 2 of the 
License, or (at your option) any later version. This program is distributed in the hope that it will be 
useful, but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY 
or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General Public License for more details. 
You should have received a copy of the GNU General Public License along with this program; if not, 
write to the Free Software Foundation, Inc., 59 Temple Place - Suite 330, Boston, MA  02111-1307, 
USA. The jModelTest distribution includes Phyml and Consense (Phylip package) executables. 
These programs are protected by their own license and conditions, and using jModelTest implies 
agreeing with those conditions as well. 
 
 
2. Purpose 
 
jModelTest is a tool to carry out statistical selection of best-fit models of nucleotide substitution. It 
implements five different model selection strategies: hierarchical and dynamical likelihood ratio 
tests (hLRT and dLRT), Akaike and Bayesian information criteria (AIC and BIC), and a decision 
theory method (DT). It also provides estimates of model selection uncertainty, parameter 
importances and model-averaged parameter estimates, including model-averaged phylogenies. The 
theoretical background is described elsewhere (Posada and Buckley 2004b; Sullivan and Joyce 
2005). 
 
 
3. Citation 
 
When using jModelTest you should cite all these: 
Posada D. In press. jModelTest: Phylogenetic Model Averaging. Molecular Biology and Evolution.  
Guindon S and Gascuel O (2003). A simple, fast and accurate method to estimate large phylogenies 

by maximum-likelihood". Systematic Biology 52: 696-704. 
 
And if you use jModelTest to build a model-averaged tree, you should also cite this: 
 
Felsenstein, J. 2005. PHYLIP (Phylogeny Inference Package) version 3.6. Distributed by the author. 

Department of Genome Sciences, University of Washington, Seattle (USA). 
http://evolution.genetics.washington.edu/phylip.html 

  
 
4. History 
 
Version 0.0 (March 2005):  started the program. 
Version 0.1 (February 2008):  the first version of jModelTest is released.  
Version 0.1.1 (April 2008):  minor changes.  
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5. Usage 
 
jModelTest is a Java program developed in Xcode under MacOS X 10.5. It provides a GUI where 
the user can select the input file (a DNA alignment) and specify the different options for the model 
selection analysis. To accomplish most of its tasks, jModelTest builds up a pipeline with several 
freely available programs:  
 

 ReadSeq (Gilbert 2007): DNA alignment reading. 
 Phyml (Guindon and Gascuel 2003): likelihood calculations. In Mac OS X and Linux the 

program uses Phyml beta version 3.0, which is faster but can be unstable. 
 Consense (Felsenstein 2005): consensus trees. 
 Ted (D. Posada): euclidean distances between trees. 

 
5.1 Operative Systems 
Although jModelTest it is optimized for MacOS X, executables are provided to run the program 
under Windows XP and Linux. In order to avoid potential problems during execution, the program 
folder and folders therein should be located under a path without spaces. 
 
5.2 Starting the program 
jModelTest can be started in the OS systems described above if a recent Java environment is 
properly installed (see http://www.java.com/). After double-clicking on the jModelTest.jar file, the 
program console, with several menus and a text panel, should open (Figure 1) (if this does not work, 
open a console prompt, move to the jModelTest folder and type “java –jar jModeltest.1.0.jar”). The 
text in this console can be edited (“Edit > …”) and saved to a file, (“Edit > Save console”) or printed 
(“Edit > Print console”) at any time.  
 

 
 

Figure 1. jModelTest console. 
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5.3 Input datafiles 
The input file for jModelTest is a DNA sequence alignment in any of the formats allowed by 
ReadSeq (Gilbert 2007) (see http://iubio.bio.indiana.edu/soft/molbio/readseq/java/), including fasta, 
phylip, nexus, and other standards (note that ReadSeq does not read in long sequence names in 
several formats). An input file can be specified by clicking on the menu “File > Load DNA 
alignment”.  
 
5.4 Likelihood settings 
Likelihood calculations are carried out with Phyml (Guindon and Gascuel 2003). There are 88 
models currently implemented in jModelTest, including 11 substitution schemes, equal or unequal 
base frecuencies (+F), a proportion of invariable sites (+I) and rate variation among sites with a 
number of rate categories (+G) (Table 1). The panel for the likelihood calculations is available from 
the menu Analysis > “Compute likelihood scores” (Figure 2). Here it is possible to a large extent to 
specify which models will be compared (a minimum of 3, and a maximum of 88). For example, the 
user can select a diferent number of substitution schemes, whose exact names will depend on the 
+F, +I and +G options. 
 
3 schemes: JC, HKY and GTR. 
5 schemes: JC, HKY, TN, TPM1, and GTR. 
7 schemes: JC, HKY, TN, TPM1, TIM1, TVM and GTR. 
11 schemes: JC, HKY, TN, TPM1, TPM2, TPM3, TIM1, TIM2, TIM3, TVM and GTR. 
 
For each model, there is the option of fixing the topology or to optimize it. In all cases branch 
lengths will be estimated and therefore counted as model paramenters. A fixed tree can be 
estimated using the BIONJ algorithm (Gascuel 1997) with the JC model, or it can be specified by the 
user from a file (in Newick format). Alternativel, potentially different BIONJ or a ML tree can be 
estimated for each model, which will require more computation time, specially for the ML 
optimization. Note that the LRTs methods will only be available when the likelihoods scores are 
calculated upon a fixed topology. 
 

 
 

Figure 2. Settings for the likelihood calculations.  
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The likelihood computations can take a very variable amount of time depending on the data, 
number of candidate models and tree optimization. The console will print out the parameter 
estimates and likelihood scores (Figure 3). In addition, a progress bar will show how these 
calculations proceed (Figure 4). 
 

 
 

Figure 3. Likelihood calculations.  
  
 

 
 

Figure 4. Progress bar for the likelihood calculations.  
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Table 1. Substitution models available in jModelTest. Any of these models can include invariable 
sites (+I), rate variation among sites (+G), or both (+I+G). 
 

Model Reference 
Free  
parameters  

Base 
frequencies Substitution rates 

Substitution 
code 

JC 
(Jukes and Cantor 
1969) 0 equal AC=AG=AT=CG=CT=GT 000000 

F81 (Felsenstein 1981) 3 unequal AC=AG=AT=CG=CT=GT 000000 

K80 (Kimura 1980) 1 equal AC=AT=CG=GT; AG=CT 010010 

HKY 
(Hasegawa, Kishino, 
and Yano 1985) 4 unequal AC=AT=CG=GT; AG=CT 010010 

TNef (Tamura and Nei 1993) 2 equal AC=AT=CG=GT; AG; CT 010020 

TN (Tamura and Nei 1993) 5 unequal AC=AT=CG=GT; AG; CT 010020 
TPM1 = K81 (Kimura 1981) 2 equal AC=GT; AT=CG; AG=CT 012210 

TPM1uf (Kimura 1981) 5 unequal AC=GT; AT=CG; AG=CT 012210 
TPM2  2 equal AC=AT; CG=GT; AG=CT 010212 

TPM2uf  5 unequal AC=AT; CG=GT; AG=CT 010212 
TPM3  2 equal AC=CG; AT=GT; AG=CT 012012 
TPM3uf  5 unequal AC=CG; AT=GT; AG=CT 012012 

TIM1ef (Posada 2003) 3 equal AC=GT; AT=CG; AG, CT 012230 
TIM1 (Posada 2003) 6 unequal AC=GT; AT=CG; AG, CT 012230 

TIM2ef  3 equal AC=AT; CG=GT; AG; CT 010232 
TIM2  6 unequal AC=AT; CG=GT; AG; CT 010232 
TIM3ef  3 equal AC=CG; AT=GT; AG; CT 012032 

TIM3  6 unequal AC=CG; AT=GT; AG; CT 012032 
TVMef (Posada 2003) 4 equal AC; AT, CG; GT; AG=CT 012314 

TVM (Posada 2003) 7 unequal AC; AT; CG; GT; AG=CT 012314 
SYM (Zharkikh 1994) 5 equal AC; AG; AT; CG; CT; GT 012345 

GTR = REV (Tavaré 1986) 8 unequal AC; AG; AT; CG; CT; GT 012345 
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5.5 Model selection and averaging 
Once all likelihood scores are in place, models can be selected according to different criteria from 
the menu (“Analysis > …”). 
 
5.5.1 Akaike information criterion (AIC) 
Under the AIC framework, the user can select whether to use the AICc (corrected for small samples) 
instead of the standard AIC, which is the default (Figure 5). If the AICc is specified, the user needs to 
specify the sample size, which by default is the number of sites in the alignment. A confidence 
interval (CI) of models including a specified fraction of the models (by default 100%) will also be 
built according to the cumulative weight. When model does not fit completely within the CI (the 
previous model in the sorted table has a cumulative weight below the CI and this model has a 
cumulative weight above the CI and) it will be included in the CI with a probability equal to the 
portion of its cumulative weight that is inside the CI. For example, in the table displayed in the 
Figure 5, the model F81+G has a probability of (0.9500 – 0.9412) / 0.0220 = 0.4 of being include 
within the 95% CI. 
 
Parameter importances are rescaled by the total weight of the models included in the confidence 
interval. In order to obtain and model averaged estimates, weights are rescaled by the parameter 
importance. If the user wish to do so, a block of PAUP* commands specifying the likelihood settings 
of the AIC model can be written to the console. 
 

 
Figure 5. Options for the AIC selection. 
 
Once the calculations have been carried out, the program reports the model selected, which is the 
one with the smallest AIC. Model selection uncertainty is displayed in a table in which models are 
sorted in increasing order according to their AIC score. This table also includes the AIC differences 
and the relative and cumulative AIC weights (Figure 6). These results are also available at the 
"Model > Show model table" menu, in which the selected model is displayed in red. After this, the 
confidence interval, parameter importances and model-averaged estimates are displayed (Figure 7). 
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Figure 6. Results of the AIC selection. -lnL: negative log likelihood;  K: number of estimated 
parameters;  AIC: Akaike Information Criterion;  delta: AIC difference;  weight: AIC weight;  
cumWeight: cumulative AIC weight. 
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Figure 7. AIC confidence interval, parameter importances and model-averaged estimates. 
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5.5.2 Bayesian information criterion (BIC) 
The options (Figure 8) and results for the BIC selection are analogous to those described above for 
the AIC, expect for the lack of a correction for small samples. 
 

 
Figure 8. Options for the BIC selection. 
 
 
5.5.3 Decision theory performance-based selection (DT) 
The options for the DT selection (Figure 9) are analogous to those described above for the BIC. 
However, the calculation of weights here is different. This because DT statistic is of a different 
nature, and the standard theory does not apply anymore. Right now, the DT weights are simply the 
rescaled reciprocal DT scores ((1/DTi)/sum). The weights reported here are very gross and should be 
used with caution. Remember also that parameter importances and model averaged estimates use 
these weights.  
 
 

 
Figure 9. Options for the DT performance-based selection. 
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5.5.4 Sequential likelihood ratio tests (sLRTs) 
Sequential likelihood ratio tests for model selection can be implemented under a particular 
hierarchy of likelihood ratio tests (sLRTs), in which the user can specify the order of the LRTs and 
whether parameters are added (forward selection) or removed (backward selection) (Figure 10). 
Alternatively, the order of the LRTs can be set automatically or dynamically (dLRTs) by comparing 
the current model with the one that is one hypothesis away and provides the largest increase (under 
forward selection) or smallest decrease (under backward selection) in likelihood (Figure 11). The 
sLRTs will be available only if the likelihoods scores were calculated upon a fixed topology, due to 
the nesting requirement of the chi-square approximation. 
 

 
Figure 10. Options for the sequential LRTs.  
 
The number and type of hypotheses tested (i.e., of LRTs performed) will depend on the particular 
models included in the candidate set. The possible tests are: 
 

 Base frequencies 
• freq = unequal base frequencies (option +F, Figure 2). 

 
 Substitution constraints (nss = number of substitution schemes in Figures 2 and 11) 

• titv = transition/transversion ratio (nss = 3 , 5, 7, 11). 
• 2ti4tv = 2 different transition rates and 4 different transversion rates (nss = 3). 
• 2ti = 2 different transition rates (nss = 5, 7, 11). 
• 2tv = 2 different transversion rates (AC=GT and AT=CG when nss = 3 and 5; all 

options for nss = 11). 
• 4tv = 4 different transversion rates (nss = 5, 7, 11). 

 
 Rate variation among sites 

• gamma = gamma-distributed rate heterogeneity (option +G, Figure 2). 
• pinv = proportion of invariable sites (option +I, Figure 2). 

 
In the case of the TIM and TPM family for nss = 11, the model with highest likelihood (TIM1 or 
TIM2 or TIM3; TPM1 or TPM2 or TPM3) will be used in the LRT. The level of significance for each 
individual LRT can be specified. By default this is value 0.01. The standard chi-square 
approximation is used in all tests, except for those involving gamma distributed rate variation among 
sites or a proportion of invariable sites, where a mixed chi-square is used instead. The default 
hierarchy for 24 models (nss=3, +F, +I, +G), in which the order of tests is titv-2titv-pinv-gamma is 
displayed in Figure 13. 
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Figure 11. Possible LRTs for different substitution types according to the number of substitution 
schemes specified (Figure 2). The exact names of the models compared will change according to the 
+F, +I and +G options and the outcome of their LRTs. 
 
 
5.6 Model averaged phylogeny 
Like any other model parameter, the program can compute a model averaged estimate of the tree 
topology (Figure 12). This estimate is obtained by calculating a weighted (using will be AIC, BIC or 
DT weights) consensus (majority rule) from all the trees corresponding to the models in the 
candidate set (or within a given confidence interval) (Figure 13). This option is only available when 
the tree topology has been optimized for every model. A strict consensus can also be computed, 
although in this case the weights have no meaning. 
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Figure 12. Options for the sequential LRTs.  
 
 

 
Figure 13. Console output showing a model-averaged phylogeny for 24 models with the AIC. 
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6. Miscellaneous options 
 
6.1 LRT calculator 
The program includes a very simple calculator to perform likelihood ratios tests using the standard 
or a mixed chi-square approximation (Figure 14). The models tested should be nested (the null 
hypothesis is a special case of the alternative hypothesis). 
 

 
Figure 14. LTR calculator. 
 
6.2 Results table 
The likelihood scores (Figure 15) and the results from the different analyses (Figure 16) are stored in 
a table that can be displayed at any time from the menu “Results > Show results table”. 
 

 
Figure 15. Model table showing the likelihood scores and parameter estimates for each value. 
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Figure 16. Model table showing the AIC scores and related measures. The AIC model is indicated in 
red. 
 
 
7. The package 
 
The jModelTest package includes several files in different subdirectories. These files should not be 
moved around. It is best to put the jModelTest folder in a path without spaces. 
 
jModelTest 

+ -------- doc 
+ -------- examples 
+ -------- exe 
 + ---- phyml 
 + ---- consense 
 + ---- ted 
+ jModelTest.x.x.jar 
+ -------- license 

 + README.html 
 
README.html: quick instructions and comments for users. 
/doc/jModelTest.x.x.pdf: Documentation in PDF format 
/examples/example.nex: an example data file in NEXUS format 
 
/exe/phyml/*: phyml executables for mac OS X, windows and linux. 
/exe/consense/*: consense executables for mac OS X, windows and linux. 
/exe/ted/*: ted executables for mac OS X, windows and linux. 
 
/license/gpl.html: GNU general public license in HTML format 
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7.1 Example file 
The example file (example.nex) included is an alignment of 10 DNA sequences 1000 bp long. This 
alignment was simulated on a tree obtained from the coalescent process and under the HKY+I 
model, with these parameter values: 
 
 Effective population size = 10000 
 Mutation rate per nucleotide per site =  5e-5  
 Base frequencies (A, C, G, T) = 0.4, 0.2, 0.1, 0.3 
 Transition/transversion rate = 4 
 Alpha parameter of the gamma distribution = 0.4 
 
 
8. Theoretical background 
 
All phylogenetic methods make assumptions, whether explicit or implicit, about the process of DNA 
substitution (Felsenstein 1988). Consequently, all the methods of phylogenetic inference depend on 
their underlying substitution models. To have confidence in inferences it is necessary to have 
confidence in the models (Goldman 1993b). Because of this, it makes sense to justify the use of a 
particular model. Statistical model selection is one way of doing this. For a review of model 
selection in phylogenetics see Sullivan and Joyce (2005) and Johnson and Omland (2003). The 
strategies includes in jModelTest include sequential likelihood ratio tests (LRTs), Akaike Information 
Criterion (AIC), Bayesian Information Criterion (BIC) and performance-based decision theory (DT). 
 
8.1 Sequential Likelihood Ratio Tests (sLRT) 
In traditional statistical theory, a widely accepted statistic for testing the goodness of fit of models is 
the likelihood ratio test statistic (LRT):  
 

  

€ 

LRT = 2  (l1 − l 0 ) 
 
where  l1 is the maximum likelihood under the more parameter-rich, complex model (alternative 

hypothesis) and  l0  is the maximum likelihood under the less parameter-rich simple model (null 
hypothesis). When the models compared are nested (the null hypothesis is a special case of the 
alternative hypothesis) and the null hypothesis is correct, the LRT statistic is asymptotically 
distributed as a χ2 with q degrees of freedom, where q is the difference in number of free parameters 
between the two models (Kendall and Stuart 1979; Goldman 1993b). Note that, to preserve the 
nesting of the models, the likelihood scores need to be estimated upon the same tree. When some 
parameter is fixed at its boundary (p-inv, α), a mixed χ2 is used instead (Ohta 1992; Goldman and 
Whelan 2000). The behavior of the χ2 approximation for the LRT has been investigated with quite a 
bit of detail (Goldman 1993a; Goldman 1993b; Yang, Goldman, and Friday 1995; Whelan and 
Goldman 1999; Goldman and Whelan 2000).  
 
8.1.1 hLRT 
Likelihood ratio tests can be carried out sequentially by adding parameters (forward selection) to a 
simple model (JC), or by removing parameters (backward selection) from a complex model 
(GTR+I+G) in a specific order or hierarchy (hLRT; see Figure 17). The performance of hierarchical 
LRTs for phylogenetic model selection has been discussed by Posada and Buckley (2004a) .  
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Figure 17. Example of a particular forward hierarchy of likelihood ratio tests for 24 models. At any 
level the null hypothesis (model on top) is either accepted (A) or rejected (R). In this example the 
model selected is GTR+I. 
 
8.1.2 dLRT 
Alternatively, the order in which parameters are added or removed can be selected automatically 
(Figure 18). One option to accomplish this is to add the parameter that maximizes a significant gain 
in likelihood during forward selection, or to add the parameter that minimizes a non-significant loss 
in likelihood during backward selection (Posada and Crandall 2001a). In this case, the order of the 
tests is not specified a priori, but it will depend on the particular data. 
 

 
 
Figure 18. Dynamical likelihood ratio tests for 24 models. At any level a hypothesis is either 
accepted (A) or rejected (R). In this example the model selected is GTR+I. Hypotheses tested are: F = 
base frequencies; S = substitution type; I = proportion of invariable sites; G = gamma rates. 
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8.2 Akaike Information Criterion 
The Akaike information criterion (AIC, (Akaike 1974) is an asymptotically unbiased estimator of the 
Kullback-Leibler information quantity (Kullback and Leibler 1951). We can think of the AIC as the 
amount of information lost when we use a specific model to approximate the real process of 
molecular evolution. Therefore, the model with the smallest AIC is preferred. The AIC is computed 
as: 

  

€ 

AIC = −2l + 2K  , 
 
where  l  is the maximum log-likelihood value of the data under this model and Ki is the number of 
free parameters in the model, including branch lengths if they were estimated de novo. When 
sample size (n) is small compared to the number of parameters (say, n/K < 40) the use of a second-
order AIC, AICc (Sugiura 1978; Hurvich and Tsai 1989), is recommended: 
 

€ 

AICc = AIC +
2K(K +1)
n − K −1

, 

 
 
The AIC compares several candidate models simultaneously, it can be used to compare both nested 
and non-nested models, and model-selection uncertainty can be easily quantified using the AIC 
differences and Akaike weights (see Model uncertainty below). Burnham and Anderson (2003) 
provide an excellent introduction to the AIC and model selection in general.  
 
 
8.3 Bayesian Information Criterion 
An alternative to the use of the AIC is the Bayesian Information Criterion (BIC) (Schwarz 1978): 
 

  

€ 

BIC = −2l+K logn  

Given equal priors for all competing models, choosing the model with the smallest BIC is equivalent 
to selecting the model with the maximum posterior probability. Alternatively, Bayes factors for 
models of molecular evolution can be calculated using reversible jump MCMC (Huelsenbeck, 
Larget, and Alfaro 2004). We can easily use the BIC instead of the AIC to calculate BIC differences 
or BIC weights.  
 
 
8.4 Performance-based selection  
Minin et al. (2003) developed a novel approach that selects models on the basis of their 
phylogenetic performance, measured as the expected error on branch lengths estimates weighted by 
their BIC. Under this decision theoretic framework (DT) the best model is the one with that 
minimizes the risk function: 

Ci ≈ B̂i − B̂ j
j=1

R

∑   e−BICi /2

e−BICi /2
j=1

R
∑

, 
where 

B̂i − B̂ j

2
= (B̂il − B̂jl )

2

l=1

2t−3

∑
 

and where t is the number of taxa. Indeed, simulations suggested that models selected with this 
criterion result in slightly more accurate branch length estimates than those obtained under models 
selected by the hLRTs (Minin et al. 2003; Abdo et al. 2005).  
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8.5 Model Uncertainty 
The AIC, Bayesian and DT methods can rank the models, allowing us to assess how confident we 
are in the model selected. For these measures we could present their differences (Δ). For example, 
for the ith model, the AIC (BIC, DT) difference is: 
 

Δi = AICi −min(AIC) , 
 
where min AIC is the smallest AIC value among all candidate models. The AIC differences are easy 
to interpret and allow a quick comparison and ranking of candidate models. As a rough rule of 
thumb, models having Δi within 1-2 of the best model have substantial support and should receive 
consideration. Models having Δi within 3-7 of the best model have considerably less support, while 
models with Δi > 10 have essentially no support. Very conveniently, we can use these differences to 
obtain the relative AIC (BIC) weight (wi) of each model: 
 

€ 

wi =
exp(−1/2Δ i )
exp(−1/2Δr )r=1

R
∑

 

 
which can be interpreted, from a Bayesian perspective, as the probability that a model is the best 
approximation to the truth given the data. The weights for every model add to 1, so we can establish 
an approximate 95% confidence set of models for the best models by summing the weights from 
largest to smallest from largest to smallest until the sum is 0.95 (Burnham and Anderson 1998, pp. 
169-171; Burnham and Anderson 2003).  This interval can also be set up stochastically (see above 
“Model selection and averaging”). Note that this equation will not work for the DT (see the DT 
explanation on “Model selection and averaging”). 
 
 
8.6 Model Averaging 
Often there is some uncertainty in selecting the best candidate model. In such cases, or just one 
when does not want to rely on a single model, inferences can be drawn from all models (or an 
optimal subset) simultaneously. This is known as model averaging or multimodel inference. See 
Posada and Buckley (2004a) and references therein for an explanation of application of these 
techniques in the context of phylogenetics. 
 
Within the AIC or Bayesian frameworks, it is straightforward to obtain a model-averaged estimate of 
any parameter (Madigan and Raftery 1994; Raftery 1996; Hoeting, Madigan, and Raftery 1999; 
Wasserman 2000; Burnham and Anderson 2003; Posada 2003). For example, a model-averaged 
estimate of the substitution rate between adenine and cytosine (ϕA-C) using the Akaike weights (wi) 
for R candidate models would be: 

ϕ̂A−C =
wi   IϕA−C (Mi )  ϕA−Cii=1

R
∑

w+ (ϕA−C ) , 
where 

€ 

w+ (ϕA−C ) = wiIϕ A−C
(Mi )i=1

R
∑ , 

and 

€ 

Iϕ A−C
(Mi ) =

1 if ϕA−C  is in model Mi

0 otherwise
 
 
 , 
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Note that need to be careful when interpreting the relative importance of parameters. When the 
number of candidate models is less than the number of possible combinations of parameters, the 
presence-absence of some pairs of parameters can be correlated, and so their relative importances.  
 
8.6.1 Model averaged phylogeny 
Indeed, the averaged parameter could be the topology itself, so we could construct a model–
averaged estimate of phylogeny. For example, one could estimate a ML tree for all models (or a best 
subset) and with those one could build a weighted consensus tree using the corresponding Akaike 
weights. See Posada and Buckley (2004a) for a practical example.  
 
8.7 Parameter importance 
It is possible to estimate the relative importance of any parameter by summing the weights across 
all models that include the parameters we are interested in. For example, the relative importance of 
the substitution rate between adenine and cytosine across all candidate models is simply the 

denominator above,

€ 

w+ (ϕA−C ). 
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